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Preface

This document describes the requirements and tasks to integrate data from external sources in 
Cisco StadiumVision Director Release 3.1. 

The content is intended for Cisco StadiumVision system administrators, content managers, and technical 
field engineers who are responsible for designing and deploying Cisco StadiumVision solutions. It is 
expected that readers of this document are familiar with basic IP networking, have a general 
understanding of the sports and entertainment business, and understand the objectives and operations of 
live events.

Document Revision History
Table 1 lists the technical changes made to this document since it was first published.

Table 1 Document Revision History 

Date Change Summary

March 27, 2013 Document was updated with the following changes:

 • Revised the restriction about content caching in the “Restrictions for 
External Content Integration” section on page 2.

 • Added statement to the “Troubleshooting Missing Data Feed Content” 
section on page 83 about preview possibly taking up to two times your 
polling interval for data to appear in your preview pane. 

March 8, 2013 Second release of this document for Cisco StadiumVision Director Release 3.1, 
which includes support for the following updates:

 • Predefined Atom and RSS data sources.

 • Generic data sources.

 • Advanced configuration support for Data views that allow you to merge data 
from multiple feeds and use an expression editor to select certain data 
elements from those feeds to be put into a single combined data source for 
presentation.

 • Preview of live data from the Data Integration interface and from the 
Widgets layout tool.

August 2, 2012 First release of this document for Cisco StadiumVision Director Release 3.0.
vii
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Preface
Obtaining Documentation and Submitting a Service Request
Document Organization

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What's New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What's New in Cisco Product Documentation as an RSS feed and set content to be 
delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco 
currently supports RSS Version 2.0. 

Chapter Description

“Overview of External Content 
Integration in Cisco StadiumVision 
Director”

Provides a high-level overview of the Cisco StadiumVision 
Director’s integration with external data sources for content 
ingestion and presentation.

“Configuring External Content 
Integration in Cisco StadiumVision 
Director”

Describes the requirements and how to configure support for 
external data sources in Cisco StadiumVision Director.

“Configuring Optional and 
Advanced Tasks for External 
Content Integration”

Describes additional tasks that can be performed to configure 
and maintain External Content Integration in Cisco 
StadiumVision Director.

“Designing the Layout of External 
Content Using the Widgets Tool”

Describes how to design the layout for display of the data that 
you have integrated and mapped for output in Cisco 
StadiumVision Director using the External Content Integration 
feature.

“Troubleshooting External Content 
Integration in Cisco StadiumVision 
Director”

Describes how to monitor and troubleshoot problems with 
External Content Integration in Cisco StadiumVision Director.
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Overview of External Content Integration in 
Cisco StadiumVision Director

First Published: August 2, 2012
Revised: March 27, 2013

Figure 1 shows a high-level overview of the content support in the External Content Integration feature 
in Cisco StadiumVision Director. Cisco StadiumVision Director Release 3.0 introduced integration with 
external data sources for content ingestion and presentation for NFL GSIS statistics, game clock, and 
certain scoreboard devices. Cisco StadiumVision Director Release 3.1 adds support for predefined data 
feeds such as RSS and Atom, as well as support for generic data sources.

Figure 1 External Content Integration High-Level Overview 

This module includes the following topics:

 • Supported External Content Sources, page 2

 • Restrictions for External Content Integration, page 2

 • Information About NFL GSIS Integration in Cisco StadiumVision Director, page 3

 • Information About Scoreboard Integration in Cisco StadiumVision Director, page 4

 • Information About Generic Data Sources in Cisco StadiumVision Director, page 5

 • Information About Content Feeds in Cisco StadiumVision Director, page 6

 • Overview of the External Content Integration Interface, page 8
1
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Overview of External Content Integration in Cisco StadiumVision Director
Supported External Content Sources
Supported External Content Sources
Cisco StadiumVision Director Release 3.1 predefines the data structures to support the following 
external content sources:

 • National Football League (NFL) Game Statistics and Information System (GSIS) Cumulative 
Statistics

 • NFL GSIS Game Clock

 • Daktronics All Sport 5000 Scoreboard Controller (basketball and hockey only)

 • OES ISC9000 Intelligent Scoreboard Controller (basketball and hockey only)

 • Atom Feed

 • RSS Feed (RSS 2.0)

In addition to these predefined data sources, Cisco StadiumVision Director also can support generic data 
sources.

Restrictions for External Content Integration
Before you configure External Content Integration, consider the following restrictions:

 • The External Content Integration feature is not venue aware. This means that any configuration 
applies to all venues and cannot be made venue-specific.

 • The frequency of the scoreboard clock updates is no more than once per second and a delay of up to 
2 seconds can occur.

 • Only basketball and hockey scoreboard statistics are currently supported.

 • RSS feed approvals must be done pre-ingestion of the content by Cisco StadiumVision Director.

 • Up to 5 images can be supported from a data source using the PicToScreen widget. For more 
information on the Widgets tool, see the “Designing the Layout of External Content Using the 
Widgets Tool” module.

 • HTTPS URLs and authentication are not supported.

 • Data from a generic data source is not cached in Cisco StadiumVision Director. This means that 
DMPs must be able to reach any externally referenced source data (for example, referenced images) 
on the network. If the DMPs, do not have access to the external data source, then you need to set up 
an  intermediary server to cache external data internally to the Cisco StadiumVision Director 
network.

Caution The import of any external flows must only be done by trained Cisco Systems personnel or partners due 
to potentially severe risks to the normal operation of the External Content Integration system.
2
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Information About NFL GSIS Integration in Cisco StadiumVision Director
Information About NFL GSIS Integration in Cisco StadiumVision 
Director

This section includes the following topics:

 • Network Considerations for NFL GSIS Integration, page 3

 • Supported NFL GSIS Data, page 3

Network Considerations for NFL GSIS Integration
The NFL GSIS statistics supported by the External Content Integration feature are transferred from data 
stored on an NFL Stats-in-a-Box (SIAB) server installed at the venue using an FTP connection to the 
Cisco StadiumVision Director server. The NFL SIAB server is a local server that connects to the central 
NFL GSIS database external to the venue and managed by the NFL.

Figure 2 shows a sample network architecture for NFL GSIS integration with Cisco StadiumVision 
Director. 

Note The actual network configuration with the NFL network is site-dependent and could vary at your venue.

Figure 2 Network Architecture for NFL GSIS Integration

It is important to note that the network where the SIAB server is installed is not necessarily (and likely 
not) on the same network where the Cisco StadiumVision Director server is installed. Therefore, 
depending on your specific network configuration, you might have some network configuration to do to 
ensure that the SIAB server is reachable by the Cisco StadiumVision Director server.

To configure the network connectivity to the NFL SIAB server you must specify the IP address, port, 
data path, username, and password for the NFL SIAB server on the Cisco StadiumVision Director server. 

Supported NFL GSIS Data
Cisco StadiumVision Director supports the NFL GSIS Game Clock and all of the statistics in the 
Cumulative Statistics XML file (CumulativeStatisticsFile). For more information and documentation for 
these statistics, go to:

http://www.nflgsis.com/gsis/

From the NFL GSIS Home page, click Documentation. Click the corresponding documentation links 
for the Cumulative Statistics Report and the Real-time Game Information (Game Clock).
3
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Overview of External Content Integration in Cisco StadiumVision Director
Information About Scoreboard Integration in Cisco StadiumVision Director
Information About Scoreboard Integration in Cisco 
StadiumVision Director

This section includes the following topics:

 • Overview of Scoreboard Integration Support, page 4

 • Network Considerations for Scoreboard Integration, page 4

Overview of Scoreboard Integration Support
Cisco StadiumVision Director scoreboard integration allows you to display real-time information (such 
as period, score, and clock) on Cisco StadiumVision Director TV displays.

Figure 3 shows a high-level overview of the scoreboard integration support. Cisco StadiumVision 
Director Release 3.0 supports the following devices and sports:

 • Daktronics All Sport 5000 Scoreboard Controller (basketball and hockey only)

 • OES ISC9000 Intelligent Scoreboard Controller (basketball and hockey only)

Figure 3 Scoreboard Integration High-Level Overview

Network Considerations for Scoreboard Integration
Cisco StadiumVision Director communicates with the supported scoreboard controllers through a User 
Datagram Protocol (UDP) port connection. Both the corresponding controller interface and the 
Cisco StadiumVision Director server must be configured to establish the network connectivity between 
these devices.
4
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Information About Generic Data Sources in Cisco StadiumVision Director
Information About Generic Data Sources in Cisco StadiumVision 
Director

Beginning in Cisco StadiumVision Director Release 3.1, support for external content integration with 
generic data sources in Cisco StadiumVision Director is introduced. Generic data sources can be used 
for other forms of XML sources that you want to ingest into Cisco StadiumVision Director whose format 
does not conform to some of the standard out-of-the-box data source types such as RSS 2.0.

Note If your data feed does not strictly conform to the standard format of the predefined data source types in 
the External Content Integration feature, then the Generic Data Source type is recommended for best 
results.

Generic Data Source Message Types
The generic data source can be configured as one of the following message types:

 • FTP

 • HTTP

 • TCP

 • UDP

Note HTTPS URLs are not supported.

Data Views
Data views can be configured to support ingestion of multiple feeds as an advanced data configuration 
option. Data views allow you to merge data from multiple feeds and use an expression editor to select 
certain data elements from those feeds to be put into a single combined data source for presentation. The 
data source can be laid out for presentation using the PicToScreen or TextToScreen components of the 
Widgets tool.
5
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Overview of External Content Integration in Cisco StadiumVision Director
Information About Content Feeds in Cisco StadiumVision Director
Figure 4 shows receipt of two independent RSS feed sources into Cisco StadiumVision Director with 
data integration of those sources into a data view that is then re-ingested into the External Content 
Integration feature as a single data source of the combined feeds. 

Figure 4 Multiple RSS Feeds Combined into Single Data Source

The newly combined data source of the two RSS feeds can be bound to a TextToScreen component in 
the Widgets tool to lay out its final presentation for use in the standard script/playlist publishing methods 
of Cisco StadiumVision Director.

For more information about configuring data views, see the “Working with Data Views” section on 
page 37.

XML Schema for Generic Data Sources
If you want to use a generic data source in the External Content Integration feature, then you must be 
able to provide the XML for a single sector (that is representative of all of the sectors) in the data feed. 
This sample data can then be used for the configuration of your data source.

Information About Content Feeds in Cisco StadiumVision 
Director

Cisco StadiumVision Director Release 3.1 enhances support for RSS feed design using the External 
Content Integration feature. It includes support for a predefined RSS data feed, and an Atom feed. 

Note The legacy Ticker feature remains available from the Control Panel in Cisco StadiumVision Director 
Release 3.1. 
6
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Information About Content Feeds in Cisco StadiumVision Director
This section includes the following topics:

 • Differences Between Legacy Ticker Feature and External Content Integration for RSS Support, 
page 7

 • Predefined Feed Sources, page 7

Differences Between Legacy Ticker Feature and External Content Integration 
for RSS Support

Table 1 provides a comparison of the differences between the legacy Ticker feature available from the 
Control Panel, and the new RSS feed support available from the External Content Integration feature in 
the Control Panel > Setup screen.

When using External Content Integration to configure your RSS feeds, approvals must be done outside 
of the Cisco StadiumVision Director software and prior to its ingestion by Cisco StadiumVision Director. 
However, the External Content Integration feature allows you to customize the layout of your RSS 
information on the display using the PicToScreen and TextToScreen components of the Widgets tool.

The primary advantage of the legacy Ticker feature is that you can do approvals of your content from 
within the user interface, but you do not have any control over the layout design.

Predefined Feed Sources
The External Content Integration feature in Cisco StadiumVision Director Release 3.1 adds support for 
the following predefined data sources for RSS and Atom support:

 • Atom Feed

 • RSS Feed

Atom Feed Data Fields

Table 2 describes the data fields that are supported in Cisco StadiumVision Director for the predefined 
Atom feed data source.

Table 1 Comparison of Ticker Feature with External Content Integration RSS Support

Feature Customized Layout UI Support for Content Approvals

Ticker (Control Panel) No Yes

External Content Integration RSS 
(Control Panel / Setup)

Yes No

Table 2 Data Fields for Mapping Atom Feeds

Data Field Description 

Title Title element in original Atom feed.

Content Content element in original Atom feed.
7
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Overview of the External Content Integration Interface
RSS Feed Data Fields

Table 3 describes the data fields that are supported in Cisco StadiumVision Director for the predefined 
RSS feed data source, which can be used as a generic data source for other RSS feeds.

Overview of the External Content Integration Interface
The External Content Integration feature is implemented using two basic areas of the Control Panel:

 • Control Panel > Setup > Data Integration

The Data Sources configuration consists of two tabs: 

 – Configuration—Use to specify the network-related and data parameters for the selected data 
source.

 – Field mapping—Use to select and map statistics for output display.

 • Control Panel > Widgets

The Widgets tool is used to add graphics and design the layout for the data that you want to display 
from the External Content Integration feature.

The remainder of the tasks associated with publishing external content to a TV display use the existing 
Cisco StadiumVision Director playlist and script creation interfaces.

Id Id element in original Atom feed.

Image First enclosure URL within a link element, if available. Otherwise, source 
URL of the first HTML image element within content.

Table 2 Data Fields for Mapping Atom Feeds

Data Field Description 

Table 3 Data Fields for Mapping RSS Feeds (Generic)

Data Field RSS Feed

Title Title element in original RSS feed.

Description Description element in original RSS feed.

Link Link element in original RSS feed.

Image First enclosure URL, if available. Otherwise, source URL of the first 
HTML image element within description.
8
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Configuring External Content Integration in 
Cisco StadiumVision Director

First Published: August 2, 2012
Revised: March 8, 2013

This module describes the requirements and how to configure support for external data sources in Cisco 
StadiumVision Director.

This module includes the following topics:

 • Before You Begin, page 9

 • Workflow Summary for External Content Integration, page 12

 • How to Configure External Content Integration, page 16

Before You Begin
Before you configure Cisco StadiumVision Director for External Content Integration, be sure that the 
following requirements are met for the system that you are integrating with:

 • Prerequisites for Configuring NFL GSIS Integration, page 9

 • Prerequisites for Configuring OES ISC9000 Scoreboard Integration, page 10

 • Prerequisites for Configuring Daktronics All Sport 5000 Scoreboard Integration, page 11

 • Prerequisites for Configuring Generic Data Sources, page 11

 • Prerequisites for Configuring RSS and Atom Data Sources, page 12

Prerequisites for Configuring NFL GSIS Integration
Before you configure the National Football League (NFL) Game Statistics and Information System 
(GSIS) integration, be sure that the following requirements are met:

 • The required Cisco StadiumVision Director server hardware is installed and running Cisco 
StadiumVision Release 3.0 or later.

 • The NFL Stats-in-a-Box (SIAB) server is installed at the venue and is connected to the NFL GSIS 
database. Advise your network administrator to allow communication between these two servers.

 • The SIAB server is reachable by the Cisco StadiumVision Director server on the Internet Protocol 
(IP) network.
9
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Configuring External Content Integration in Cisco StadiumVision Director
Before You Begin
 • For support of the NFL GSIS clock, a router in the network must be configured for Network Address 
Translation (NAT) to change the local broadcast address to the unicast IP address of the Cisco 
StadiumVision Director server.

Tip You can verify reachability using the ping command from the Cisco StadiumVision Director 
server to the SIAB server. 

 • The NFL GSIS representative has provided the SIAB IP address and account information, which 
will be needed to configure Cisco StadiumVision Director connectivity to the SIAB server.

Prerequisites for Configuring OES ISC9000 Scoreboard Integration
Before you configure the OES ISC9000 Intelligent Scoreboard Controller integration, be sure that the 
following requirements are met:

 • The required Cisco StadiumVision Director server hardware is installed and running Cisco 
StadiumVision Release 3.0 or later.

 • The OES ISC9000 Scoreboard controller is installed at the venue (preferably in the Cisco 
StadiumVision network).

 • The OES ISC9000 Scoreboard controller is reachable by the Cisco StadiumVision Director server 
on the Internet Protocol (IP) network.

 • A site administrator or OES equipment vendor has added the Cisco StadiumVision Director server 
IP address and UDP port number in the OES controller.

Note Be sure to record the UDP port number used in the OES ISC9000 controller so that you can 
configure the same port in the network connection information for Cisco StadiumVision 
Director.

Figure 1 shows an example of the interface for the Serial Port Configuration on the OES ISC9000 
controller where the Cisco StadiumVision Director server information must be added.

Figure 1 OES ISC9000 Configuration
10
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Before You Begin
Prerequisites for Configuring Daktronics All Sport 5000 Scoreboard Integration
Before you configure the Daktronics All Sport 5000 Scoreboard integration, be sure that the following 
requirements are met:

 • The required Cisco StadiumVision Director server hardware is installed and running Cisco 
StadiumVision Release 3.0.

 • The Daktronics Scoreboard controller is installed at the venue (preferably in the Cisco 
StadiumVision network).

 • The Daktronics Scoreboard controller is reachable by the Cisco StadiumVision Director server on 
the Internet Protocol (IP) network.

 • A site administrator or Daktronics equipment vendor has added the Cisco StadiumVision Director 
server IP address in the Daktronics Scoring Timing Interface Application. 

Figure 2 shows an example of the DSTI application for the Daktronics controller where the Cisco 
StadiumVision Director server information must be added.

Figure 2 Daktronics All Sport 5000 Configuration

Prerequisites for Configuring Generic Data Sources
Before you configure generic data sources, be sure that the following requirements are met:

 • You know the message type of the data source (TCP, HTTP, FTP, or UDP).

 • You have the corresponding connection information for the specified message type. 

 • You have a copy of one unique sector of the XML data from the source feed that can be used as 
sample data for the External Content Integration configuration.

 • Cisco StadiumVision Director must be able to reach any externally referenced source data (for 
example, referenced images) on the network.
11
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Configuring External Content Integration in Cisco StadiumVision Director
Workflow Summary for External Content Integration
Prerequisites for Configuring RSS and Atom Data Sources
Before you configure RSS data sources, be sure that the following requirements are met:

 • You have the source URL for the data feed.

Workflow Summary for External Content Integration

Note This workflow assumes that you have completed the required backend network installation and 
integration at your venue for the external data sources that you plan to support, such as with the NFL 
GSIS network and Stats-in-a-Box (SIAB) server, or scoreboard device.

The following steps summarize the overall workflow to integrate data into Cisco StadiumVision Director 
and display that content on a TV:

Control Panel Setup Interface—Data Integration Tab (Figure 3)

1. From the Control Panel, access the Data Integration interface.

2. Add the predefined data source type that you want to configure.

3. Complete the network settings configuration.

4. Modify any data configuration options (for example, throttling), as applicable.

5. Modify the image display width and height, as applicable. 

6. Save the configuration.

7. Enable the data collection (click Deploy).

Note Whenever you modify and save or deploy/undeploy the External Content configuration, you 
must activate and restart the application in the Management Dashboard. Cisco StadiumVision 
Director prompts you to do this, and it can be done at this step or after you finish mapping and 
formatting your statistics.
12
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Configuring External Content Integration in Cisco StadiumVision Director
Workflow Summary for External Content Integration
Figure 3 Data Integration Configuration Workflow 
13
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Configuring External Content Integration in Cisco StadiumVision Director
Workflow Summary for External Content Integration
Control Panel Setup Interface—Field Mapping Tab (Figure 4)

8. Complete the field mapping for the selected data source by selecting the available statistics that you 
want to display in Cisco StadiumVision Director.

Note For generic data sources, you must first provide sample XML data before you can complete the 
field mapping.

9. Format each statistic to set the output field name and any other output criteria as desired. Click Ok. 
Save the mapping.

Figure 4 Field Mapping Workflow
14
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Configuring External Content Integration in Cisco StadiumVision Director
Workflow Summary for External Content Integration
Management Dashboard—External Content Integration (Figure 5)

10. Activate and restart the External Content Integration application from the Management Dashboard.

Figure 5 External Content Integration Application in Management Dashboard

Control Panel Widgets Interface

11. Use the Widgets tool from the Control Panel to design a layout of the statistics that you configured 
to add graphics and bind/position data fields, and save the widget (Figure 6). See the “Designing the 
Layout of External Content Using the Widgets Tool” module for more information.

Figure 6 Widgets Tool

12. Create a playlist from the Control Panel for the widget that you created. Widgets are categorized in 
the “By Type” folder under the “widget” type (Figure 7).

Tip Click the Refresh icon in Content screen to see the widget in content library.
15
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Configuring External Content Integration in Cisco StadiumVision Director
How to Configure External Content Integration
Figure 7 Widget Types in Content Screen

13. Create an event script to run the playlist.

14. Schedule the script to display the content on a TV just like other pieces of content in Cisco 
StadiumVision Director.

How to Configure External Content Integration 
This section includes the following tasks:

 • Accessing the External Content Integration Interface, page 17 (required)

 • Adding a New Data Source, page 17 (required)

 • Configuring the Network Connection to the External Content Source, page 17 (required)

 • Configuring the Data Options, page 24 (optional)

 • Configuring the Image Display Size for Atom and RSS Feeds, page 27 (optional)

 • Providing Sample XML Data for Generic Data Sources, page 28 (required)

 • Selecting Input Statistics and Mapping to Output Fields for Display, page 30 (required)

 • Enabling the Data Source Configuration, page 31 (required)

 • Activating External Content Integration System-Wide From the Management Dashboard, page 32 
(required)

 • Restarting the External Content Integration Application, page 33 (required)

 • Activating External Content Integration System-Wide From the Management Dashboard, page 32 
(required)
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Accessing the External Content Integration Interface

To access the external content integration interface, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the main menu, click Control Panel.

Step 3 From the Setup screen, select Data Integration.

The Data Integration screen is displayed in the Data Sources panel view.

Adding a New Data Source

To add a new data source, complete the following steps:

Step 1 From the Data Sources tab view on the Data Integration screen, click the plus (+) icon.

The Create new data source connection dialog box is displayed.

Step 2 In the Data source name box, type a name for the data source that you want to add.

Tip Specify a name using upper or lowercase alphabetical characters, digits 0–9, hyphen (-), or 
underscore (_). Spaces are not supported.

Step 3 Under the Type column, select the data source type that you want to add.

Step 4 (Generic Data Source only) For a Generic Data Source, select the message type from the drop-down box.

Step 5 Click Create.

The new data source is displayed in Data Sources panel view, and the Configuration panel is displayed.

What To Do Next

Configure the network connection for your data source type. For more information, see the “Configuring 
the Network Connection to the External Content Source” section on page 17.

Configuring the Network Connection to the External Content Source
Complete one or more of the following tasks according to the external content sources that your site is 
going to use:

 • Configuring the Connection to the NFL GSIS SIAB Server, page 18

 • Configuring the Connection to the Scoreboard Controllers, page 20

 • Configuring the Connection to an Atom or RSS Feed, page 22

 • Configuring the Connection to a Generic Data Source, page 22
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Configuring the Connection to the NFL GSIS SIAB Server

This section includes the following topics:

 • Configuring the Network Settings for NFL Cumulative Statistics, page 18

 • Configuring the UDP Connection for the NFL Game Clock, page 19

Configuring the Network Settings for NFL Cumulative Statistics

Note Before you configure the FTP connection, be sure that you have the IP address and account credentials 
for the SIAB server from your NFL GSIS representative.

Cisco StadiumVision Director uses FTP port 21 to communicate to the NFL GSIS SIAB server to obtain 
the GSIS statistics.

To configure the network connection to the NFL GSIS SIAB server, complete the following steps:

Step 1 Go to the Configuration screen for the selected GSIS: NFL,Cumulative Statistics data source.

Step 2 In the Network settings section, configure the following options (Figure 8):

a. In the Server (IP Address) box, type the IP address of the SIAB server.

b. In the Port box, type 21. The default is 21.

c. In the Data path box, type “/”. The default is /.

d. In the User box, type the username for the SIAB server account. The default is nfl.

e. In the Password box, type the password for the SIAB server account. The default is nfl.

Figure 8 NFL Cumulative Statistics Network Configuration
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Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Configure the data options for the NFL Cumulative Statistics data source. For more information, see the 
“Configuring Data Options for NFL Cumulative Statistics” section on page 26.

Configuring the UDP Connection for the NFL Game Clock

Cisco StadiumVision Director uses UDP port 50000 to communicate to the NFL GSIS SIAB server to 
obtain the GSIS game clock.

To configure the UDP connection for the NFL game clock, complete the following steps:

Step 1 Go to the Configuration screen for the selected GSIS: NFL,Clock data source.

Step 2 In the Network settings section, configure the following options (Figure 9):

a. In the StadiumVision Director (IP Address) box, type the IP address of the Cisco StadiumVision 
server.

Tip The actual IP address of the Cisco StadiumVision server that you are logged into is provided in 
shadow, but you must type the address in the box to configure it.

b. In the StadiumVision Director port box, type 50000. The default is 0.
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Figure 9 NFL Game Clock Network Configuration

Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Configure the data options for the NFL Clock data source. For more information, see the “Configuring 
the Incoming Data Filter Rate for Data Sources” section on page 27.

Configuring the Connection to the Scoreboard Controllers

Cisco StadiumVision Director uses a UDP port to communicate to the controllers to obtain the 
scoreboard statistics. 

Note The UDP port for the OES ISC9000 Scoreboard controller varies, but the UDP port for the Daktronics 
All Sport 5000 Scoreboard controller is always 21300. Be sure that you know the UDP port being used 
for the OES controller.

To configure the UDP connection to the scoreboard controllers, complete the following steps:

Step 1 Go to the Configuration screen for the selected scoreboard data source.

Step 2 In the Network settings section, configure the following options (Figure 10):

a. In the StadiumVision Director (IP Address) box, type the IP address of the Cisco StadiumVision 
server.
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Tip The actual IP address of the Cisco StadiumVision server that you are logged into is provided in 
shadow, but you must type the address in the box to configure it.

b. In the StadiumVision Director port box, type the UDP port number used to connect to the scoreboard 
controller.

Note For the Daktronics All Sport 5000 Scoreboard controller, the UDP port is always 21300 
(Figure 10).

Figure 10 Daktronics Scoreboard Controller Network Configuration

Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Configure the data options for the scoreboard data source. For more information, see the “Configuring 
the Incoming Data Filter Rate for Data Sources” section on page 27.
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Configuring the Connection to an Atom or RSS Feed

To configure the connection to an Atom or RSS feed, complete the following steps:

Step 1 Go to the Configuration screen for the selected Atom Feed or RSS Feed data source.

Step 2 In the Network settings section, specify the URL in the Data source URL address box (Figure 11):

Figure 11 RSS Network Configuration

Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Configure the data options as needed for the Atom or RSS feed data source. For more information, see 
the “Configuring Data Options for Atom and RSS Feeds” section on page 24.

Configuring the Connection to a Generic Data Source

The connection settings for a generic data source type depend on the message type that is configured 
when creating the data source. The generic data source can be configured to support one of the following 
message types:

 • FTP

 • HTTP
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 • TCP

 • UDP

Note HTTPS URLs are not supported.

To configure the connection to the generic data source, complete the following steps:

Step 1 Go to the Configuration screen for the selected Generic Data Source name.

Step 2 Do one of the following to specify the generic data source location:

To configure the connection using FTP, specify the following information (Figure 12):

Figure 12 Generic Data Source Configuration: FTP 

 • Server (IP address)—IP address of the FTP server.

 • Port—FTP port used in Cisco StadiumVision Director for the FTP server connection. The default is 
21.

 • Data path—Folder path for the data. The default is “/”.

 • User—Username for the FTP server connection.

 • Password—Password for the user account on the FTP server.

 • Polling frequency—Number (in seconds) that specifies how often to poll data from the source. The 
default is 60.

 • File name filter—Fully-qualified file name or file name with an asterisk (*) wildcard.

To configure the connection using HTTP, specify the following information (Figure 13):

Figure 13 Generic Data Source Configuration: HTTP

 • HTTP URL—Fully qualified HTTP URL to the data source.
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Note HTTPS is not supported.

 • Polling frequency—Number (in seconds) that specifies how often to poll data from the source. The 
default is 60.

To configure the connection using TCP or UDP, specify the following information (Figure 14):

Figure 14 Generic Data Source Configuration: TCP and UDP

 • StadiumVision Director (IP Address)

 • StadiumVision Director port

Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Provide sample XML data for the generic data source. For more information, see the “Providing Sample 
XML Data for Generic Data Sources” section on page 28.

Configuring the Data Options
The data configuration options vary by the data source type:

 • Configuring Data Options for Atom and RSS Feeds, page 24

 • Configuring Data Options for NFL Cumulative Statistics, page 26

 • Configuring the Incoming Data Filter Rate for Data Sources, page 27

Configuring Data Options for Atom and RSS Feeds

To configure data options for Atom and RSS feeds, complete the following steps:

Step 1 Go to the Configuration screen for the selected Atom Feed or RSS Feed data source.

Step 2 In the Data configuration section, set one or more of the following options (Figure 15):
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Figure 15 Data Configuration Options for Atom and RSS Feeds

a. Number of messages keep—Number of messages to keep from the feed. The default is 5. 

Tip If planning to use images from the feed for the PicToScreen component in the Widgets tool, then 
a maximum of 5 images can be displayed. It is recommended that the number of messages to 
keep is 5 for images.

b. Data polling interval—Number (in seconds) for the frequency to poll data from the source feed. The 
default is 60. 

Tip 60 seconds is the recommended polling interval for images. Consider a longer interval for text 
feeds.

c. Cache period—Amount of time (in minutes) to retain polled data. The default is 30.

What To Do Next

Configure the image size as needed for the Atom or RSS feed data source. For more information, see the 
“Configuring the Image Display Size for Atom and RSS Feeds” section on page 27.
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Configuring Data Options for NFL Cumulative Statistics

To configure data options for NFL cumulative statistics, complete the following steps:

Step 1 Go to the Configuration screen for the selected GSIS: NFL, Cumulative Statistics data source.

Step 2 In the Data polling, filtering, and throttling section, set one or more of the following options (Figure 16):

Figure 16 NFL Cumulative Statistics Data Configuration Options

 • File name—Name of the cumulative statistics file on the SIAB server. The default is 
GSISGameStats.xml.

 • Wait to read data from source (FTP polling interval)—Number (in milliseconds) that specifies how 
often to retrieve data from the SIAB server. The is 60.

Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Enable the data source. For more information, see the “Enabling the Data Source Configuration” section 
on page 31.
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Configuring the Incoming Data Filter Rate for Data Sources

Note This data option is available for the GSIS NFL clock, Daktronics, and OES scoreboard data sources.

To configure the incoming data filter rate for data sources, complete the following steps:

Step 1 Go to the Configuration screen for the selected NFL clock or scoreboard controller data source.

Step 2 In the Incoming data filter rate box, specify the number (in seconds) that specifies the amount of time to 
ignore duplicate data and process only new data (Figure 18). The default is 20.

Figure 17 Incoming Data Filter Rate Option

Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Enable the data source. For more information, see the “Enabling the Data Source Configuration” section 
on page 31.

Configuring the Image Display Size for Atom and RSS Feeds
Image dimensions are retained from the original source unless you change the image display size options 
from the default values of width 0 and height 0. If you specify the image width and height, then the 
source images from that data feed will be resized.

To configure the image display size, complete the following steps:

Step 1 Go to the Configuration screen for the selected data source type.

Step 2 In the Image display section, set one or more of the following options using the spinner control:

a. In the Width box, select the horizontal dimension of the image (in pixels).

b. In the Height box, select the vertical dimension of the image (in pixels).
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Step 3 Click Save.

A message box appears asking you to restart the application.

Step 4 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

What To Do Next

Select the input statistics that you want to map for output display. For more information, see the 
“Selecting Input Statistics and Mapping to Output Fields for Display” section on page 30.

Providing Sample XML Data for Generic Data Sources

Note This task is only required when you are configuring a Generic Data Source.

Prerequisites

Before you begin this task, obtain a sample of your XML file and groom it to remove any repeating 
elements to streamline the processing and avoid reaching limits on the size of the file that can be used 
in the Data Integration interface. This sample will be used to “train” the system on the content to be 
expected from the configured generic data source.

Procedure

To provide sample XML data for generic data sources, complete the following steps:

Step 1 Go to the Field Mapping screen for the selected generic data source.

Step 2 Click the pencil icon (Figure 18).

Figure 18 Update Sample Data for Generic Data Source Field Mapping 

Step 3 In the Sample data panel, paste the representative XML code from your sample file and click the Save 
icon.
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Figure 19 shows an excerpt of XML code from a source for BATS Exchange data.

Figure 19 Paste XML into Sample Data Panel

The input fields with sample data from the saved XML source that you pasted are shown in the Field 
Mapping screen. You can expand the fields to show more data elements (Figure 20).
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Figure 20 Paste XML into Sample Data Panel

What To Do Next

Select the input statistics that you want to map for output display. For more information, see the 
“Selecting Input Statistics and Mapping to Output Fields for Display” section on page 30.

Selecting Input Statistics and Mapping to Output Fields for Display

To select input statistics and map to output fields for display, complete the following steps:

Step 1 Go to the Field Mapping screen for the selected data source.

Step 2 To view the available statistics, click the arrow beside the data file name to expand the list.

The Sample Data column displays a representative value for each statistic.

Step 3 With your mouse, select a statistic and drag-and-drop it to the Output Fields panel on the right.

The Add Output field dialog box is displayed.
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Step 4 Modify the Output field name or other mapping options as needed.

For more information, see the “Modifying the Output Format of a Statistic” section on page 43.

Step 5 Continue to select and add statistics to the Output fields panel.

Step 6 Click Save.

What To Do Next

Enable the data source. For more information, see the “Enabling the Data Source Configuration” section 
on page 31.

Enabling the Data Source Configuration
By default, external data collection and configuration is disabled. Once you have completed your 
configuration, you must both enable the data source and save the configuration to allow collection of the 
data. 

Disabled data sources are indicated by a gray checkmark in the Enabled column of the corresponding 
data source name. When a data source is enabled, the checkmark turns green.

Note Real-time data collection from the SIAB server will not begin until the External Content Integration 
application has been both enabled and restarted in Cisco StadiumVision Director. For more information, 
see the “Activating External Content Integration System-Wide From the Management Dashboard” 
section on page 28 and “Restarting the External Content Integration Application” section on page 29.

To enable the data source configuration, complete the following steps:

Step 1 In the left pane, select the data source.

Step 2 Click Deploy.

A message box appears asking you to restart the application.
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Step 3 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 29. 

Note To disable a data source configuration, repeat this task but click Undeploy at Step 2.

Activating External Content Integration System-Wide From the Management 
Dashboard

By default, External Content Integration is disabled system-wide in Cisco StadiumVision Director. After 
you have saved and enabled your data source configuration, you must activate the application and restart 
it from the Management Dashboard before data collection can begin.

The External Content Integration application must only be activated once to deploy it in the Cisco 
StadiumVision Director server. Once the External Content Integration application has been activated in 
the system, then any time the configuration has been changed, the application only must be restarted.

To activate External Content Integration system-wide, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3 Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4 Select Activate Application. 

Step 5 Click the Play button. 

Step 6 When the confirmation message box appears, click Ok to run the command.
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Step 7 To verify the application activation, look for the success message in the log display area of the screen.

Step 8 After the processing has completed, select Restart Application. 

For more information, see the “Restarting the External Content Integration Application” section on 
page 29.

Restarting the External Content Integration Application 
Any time that you have made a change to the External Content Integration settings on the Configuration 
tab for external data sources, you must restart the application from the Cisco StadiumVision Director 
Management Dashboard. 

When you save the configuration, a message is displayed as a reminder to restart:

Note Changes to the data source field mapping only need to be saved, but the application does not have to be 
restarted. However, if for some reason you did not do a restart of the application after making changes 
in the Configuration tab before going on to save changes in Field mapping, then you also will see this 
message about the required restart at the time you save the Field mapping.

To restart the External Content Integration Application, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3 Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4 Select Restart Application. 

Step 5 Click the Play button to run the command.

Step 6 When the confirmation message box appears, click Ok to run the command.
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Step 7 To verify the application activation, look for the success message in the log display area of the screen.

Verifying the Integration
This section includes the following topics:

 • Verifying Receipt of Real-Time Data, page 34

 • Verifying the Integration Broker Service Status, page 35

Verifying Receipt of Real-Time Data

Assuming that your network connection to the external data source is available and you have enabled the 
data source, real-time data is collected after you both activate and restart the application in the 
Management Dashboard.

To verify the receipt of real-time data, complete the following steps:

Step 1 From the Data Integration interface, select the data source that you want to verify.

Step 2 Click Field mapping.

Step 3 In the Output field panel, select the link in the Data preview column.

Figure 21 shows selection of a Mozes RSS feed with two image items available for data preview from 
the active feed.

Figure 21 Data Preview Example 

After you click the link, a Preview window opens displaying the live data from your feed. 

Figure 22 shows an example of the images along with their corresponding URLs that are displayed in 
the preview window. 

Tip Use the scroll bar to see all of the available preview data. 
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Figure 22 Image Preview of Active RSS Feed

Step 4 Click x to close the window.

Verifying the Integration Broker Service Status

To verify the integration broker service status, complete the following steps:

Step 1 From the Management Dashboard, go to the Service Alerts pane in the bottom right corner.

Step 2 Navigate to find the Integration Broker service name and observe its status icon.

When the icon is green, the External Content Integration service is successfully activated.
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Configuring Optional and Advanced Tasks for 
External Content Integration

First Published: August 2, 2012
Revised: March 8, 2013

This module describes some of the optional and advanced tasks that you can perform for External 
Content Integration in Cisco StadiumVision Director.

This module includes the following topics:

 • Working with Data Views, page 37

 • Disabling the Data Source Configuration, page 46 

 • Deactivating the External Content Integration Application From the Management Dashboard, 
page 46 

 • Modifying the Output Format of a Statistic, page 43

Working with Data Views
This section describes how to select and merge content from multiple data sources into a single data view 
for ingestion into Cisco StadiumVision Director and prepare the content for presentation. 

Prerequisites
Before you create a data view, be sure that the following requirements are met:

 • The data sources whose content elements you want to combine into a data view are added and 
configured. For more information, see the “Configuring External Content Integration in 
Cisco StadiumVision Director” module on page 9.

 • If you want to select specific elements of the data feed, use the Expression Editor to filter the 
elements that you want to include or exclude. For more information, see the “Modifying the Default 
XPath Expression” section on page 45.
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Task List
This section includes the following tasks:

 • Creating a Data View, page 38 (required)

 • Adding Data Sources to the Data View, page 39 (required)

 • Enabling the Data View, page 41 (required)

 • Configuring the Data View as a New Data Source, page 42 (required)

Creating a Data View

To create a data view, complete the following steps:

Step 1 From the Control Panel > Setup screen, click Data Integration.

The Data Integration screen is displayed in the Data Sources panel view.

Step 2 Click Advanced.

Step 3 To create a new data view, click +Add in the Advanced panel.

The New data view dialog box is displayed (Figure 1).

Figure 1 New data view Dialog Box

Step 4 In the Data view name box, type the name of the view that you want to create.
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Step 5 Click Create.

The new data view is added to the list of Data view names (Figure 2).

Figure 2 New data view Panel

Adding Data Sources to the Data View

Any data source type can be added to a data view.

To add data sources to the data view, complete the following steps:

Step 1 To add a data source and its configured fields to the selected data view, click the plus (+) icon in the Data 
fields panel (Figure 3).

Figure 3 Add Data Source Fields
39
Cisco StadiumVision Director External Content Integration Guide

 



 

Configuring Optional and Advanced Tasks for External Content Integration
Working with Data Views
A list of the available configured data sources is displayed in the Add or select data source panel 
(Figure 4). 

Tip The example shows generic data sources, but any data source type can be added to a data view.

Figure 4 Add or select data source Panel

Step 2 To add a data source to the data view, select a source name from the list and click <<. Repeat this step 
for as many data sources as you want to combine in the data view.

Note Multi-selection of data sources is not supported.

The sources that you added are displayed under the Data source column (Figure 5).
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Figure 5 Data Sources Selected in Data View

Step 3 After you have added all required data sources, click Done.

Step 4 Click Save.

Enabling the Data View

Disabled data views are indicated by a gray checkmark in the Enabled column of the corresponding data 
view name. When a data view is enabled, the checkmark turns green.

To enable the data view, complete the following steps:

Step 1 To enable the data view, select the data view name and click the checkmark icon (Figure 6).

Figure 6 Enable Data View

Step 2 Click Save.
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Configuring the Data View as a New Data Source

After you create a data view, you must configure it as a new data source to make the data available to the 
External Content Integration feature.

Prerequisites

Before you configure the data view as a new data source, be sure that the following requirements are met:

 • You have the internal URL that identifies the location of the view. The format of the URL is shown 
in the following example, where svd-ip-address is the IP address of the Cisco StadiumVision 
Director server and dataview-name is the name of the data view that you created:

http://svd-ip-address:8888/StadiumVision/flows/dataview/data/dataview-name

In our example, the following URL would be used:

http://10.10.10.10:8888/StadiumVision/flows/dataview/data/My_Data_View

 • You have sample XML data for the combined data sources.

Tip You can use the data view URL to get the sample XML data.

Procedure

To configure the data view as a new data source, complete the following steps:

Step 1 From the Data Integration screen, click Data Sources.

Step 2 Add a new Generic Data Source with the HTTP message type.

Step 3 Type the internal URL to the configured data view (Figure 7).

Figure 7 HTTP URL for Data View 

Step 4 Click Field Mapping.
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Step 5 Provide the sample XML data. 

For more information, see the “Providing Sample XML Data for Generic Data Sources” section on 
page 28.

Step 6 Select the input fields and map them for display.

Fore more information, see the “Selecting Input Statistics and Mapping to Output Fields for Display” 
section on page 30.

Step 7 Enable the data source.

For more information, see the “Enabling the Data Source Configuration” section on page 31.

Step 8 Verify the data integration.

For more information, see the “Verifying the Integration” section on page 34.

What To Do Next

After you have defined, enabled and verified your data view as new data source, go to the Widgets tool 
to layout the content. For more information, see the “Designing the Layout of External Content Using 
the Widgets Tool” module on page 49.

Modifying the Output Format of a Statistic
You can use the default format and value of a mapped statistic for output using the default “Pass through 
input field” option, or you can modify its characteristics for display. 

The following types of actions can be taken on input field data:

 • Changing the Output Field Name, page 44

 • Adding a Prefix or Suffix String to a Field, page 44

 • Looking Up Content, page 45

 • Modifying the Default XPath Expression, page 45
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This editing can be done either when you first add a statistic to the Output fields panel (in the Add Output 
field dialog box), or later if you edit the statistic from the Output fields panel (in the Edit Output field 
dialog box) as shown in Figure 8.

Figure 8 Change Output Field Dialog Box

Changing the Output Field Name

To change the output field name, complete the following steps:

Step 1 In the Output field name box of the Change Output field dialog box, type the new name of the field that 
you want to use.

Step 2 Click Ok.

Adding a Prefix or Suffix String to a Field
You can add a character string as a prefix or suffix to the input field value. For example, if the default 
input value for an input field called Period1 was a numeric value “1,” you could specify “st” in the suffix 
box so that the input field value is appended with this string and appears in the output as “1st.”

To add a prefix or suffix string to an input field, complete the following steps:

Step 1 In the Mapping section of the Change Output field dialog box, select the Add option.

Step 2 Do one of the following:

 • To add a character string as a prefix to the input field value, type the string in the Prefix box.

 • To add a character string as a suffix to the input field value, type the string in Suffix box.

Step 3 Click Ok.
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Looking Up Content 
You can find an image from the content library to display in the widget. An image can be located using 
the image name (such as “Image1.png”), either as part of the value of the input field or as an explicit 
reference in the text box. If you are locating the image as part of the input field, be sure to select the 
“Lookup by input field reference” checkbox.

To look up content, complete the following steps:

Step 1 In the Mapping section of the Change Output field dialog box, select the Content lookup option.

Step 2 Do one of the following:

 • To specify the explicit filename, either type the filename in the Lookup key box or click Select to 
browse for it.

 • Click the “Lookup by input field reference” checkbox if you want the image to be located as part of 
the input field data.

Step 3 Click Ok.

Modifying the Default XPath Expression
Currently, the two functions supported in the External Content Integration feature are “lookup” and 
“concat.”

Tip For information about XPath expressions, see the following URL: 
 
http://www.w3schools.com/xpath/default.asp

To modify the default XPath expression, complete the following steps:

Step 1 In the Mapping section of the Change Output field dialog box, select the Expression option.

Step 2 Click Expression Editor.

The Expression Editor dialog box is displayed.

Step 3 In the text editor box where the expression for the input field function is displayed, modify the 
expression using standard XPath expression syntax.

Step 4 Click Ok.

Choosing Specific Items From a Feed

Use the position() XPath predicate to include or exclude specific items from a given feed. 

The following expression shows the default syntax for an RSS feed using the title element:

/rss/channel/item/title/text()
45
Cisco StadiumVision Director External Content Integration Guide

 

http://www.w3schools.com/xpath/default.asp


 

Configuring Optional and Advanced Tasks for External Content Integration
Disabling the Data Source Configuration
Example 1

To modify this expression to select only the third and fourth data elements from the feed, modify the 
expression to add the following position predicate:

/rss/channel/item[position()>2 and position()<5]/title/text()

Example 2

To modify the expression to include the second, third and fourth data elements from the feed, use the 
following position predicate:

/rss/channel/item[position()>=2 and position()<5]/title/text()

Disabling the Data Source Configuration
To disable the data source configuration, complete the following steps:

Step 1 In the left pane, select the data source.

Step 2 Click Undeploy.

A message box appears asking you to restart the application.

Step 3 If you have completed all of the changes that you want to make on the Configuration tab, restart the 
application.

For more information, see the “Restarting the External Content Integration Application” section on 
page 27. 

Deactivating the External Content Integration Application From 
the Management Dashboard

By default, the External Content Integration Application is deactivated in Cisco StadiumVision Director.

If you have activated the application, but your site is no longer going to connect to any external servers, 
then you can deactivate it to disable the functionality of the application system-wide in Cisco 
StadiumVision Director.

To deactivate the External Content Integration application, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3 Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4 Select Deactivate Application. 

Step 5 Click the Play button to run the command.
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Step 6 When the confirmation message box appears, click Ok to run the command.

Step 7 After the processing has completed, select Restart Application and click the Play button.

Step 8 When the confirmation message box appears, click Ok to run the command.

The deactivation of the application will be completed.
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Designing the Layout of External Content Using 
the Widgets Tool

First Published: August 2, 2012
Revised: March 8, 2013

This module describes how to design the layout for display of the data that you have integrated and 
mapped for output in Cisco StadiumVision Director using the External Content Integration feature. This 
layout is required to create a content object referred to as a widget, that you can then publish with the 
standard features of Cisco StadiumVision Director using playlists and scripts for eventual display on 
TVs.

This module includes the following topics:

 • Prerequisites for Using the Widgets Tool, page 49

 • Restrictions for Using the Widgets Tool, page 50

 • Information About Using the Widgets Tool, page 50

 • How to Design the Layout of External Content for Display, page 58

 • Configuration Examples, page 67

 • What to Do Next, page 79

Prerequisites for Using the Widgets Tool
Before you design the layout of external content, be sure that the following requirements are met:

 • You have configured the external data sources and mapped the statistics to output fields in the 
External Content Integration feature.

 • The data from the external source is being properly ingested by Cisco StadiumVision Director.

 • You have added any standalone graphics that you want to add to the layout by importing them into 
Cisco StadiumVision Director from Control Panel > Content > Import.
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Restrictions for Using the Widgets Tool
Before you design the layout of external content using the Widgets tool, consider the following 
restrictions:

 • The Widgets layout tool can only be used for data sources that have been integrated into Cisco 
StadiumVision Director using the External Content Integration feature. 

 • Cisco StadiumVision Director only supports widgets that are created internally using the Widgets 
tool.

 • Up to16 different sessions can be supported in the Widgets tool on a single computer.

 • The maximum graphic size supported is 1920x1080, which is also the maximum size of the area 
supported in the Widgets layout tool. 

Note If you attempt to use a larger graphic in the Widgets tool, it might not be displayed.

 • The PicToScreen component has the following restrictions:

 – A maximum of 5 images can be rotated using the PicToScreen component. Therefore, up to the 
first 5 images received from the data feed can be displayed. A new set of images can be retrieved 
at the next polling interval.

 – Supports binding of image data fields only from a source feed. Therefore, the data source must 
be defined with an image field for output display. For more information on field mapping in the 
data source, see the “Selecting Input Statistics and Mapping to Output Fields for Display” 
section on page 30.

 • The TextToScreen component supports binding of text data fields from a source feed. Therefore, the 
data source must be defined with a title, description, or other text data field for output display.

 • The Widgets tool has the following font restrictions: 

 – Only the Arial font type with the ASCII character set is supported.

Note While you might be able to see a supported localized language and create text components with 
non-ASCII characters in the Widgets tool, these text components might not be rendered as 
expected on the DMP.

 – The maximum font size is limited to 128 due to a restriction by the DMP.

 – Importing of fonts is not supported.

 • The following functions are not supported in the Widgets tool:

 – Undo 

 – Deleting a group of multi-selected components

Information About Using the Widgets Tool
This section includes the following topics:

 • Components, page 51

 • Layers, page 53
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 • Properties and Effects, page 53

 • Data Binding and Preview, page 57

 • User Interface Characteristics, page 57

Components
Overall, the Widgets tool includes four component types, which are either image-based or text-based. 
New components are added to the widget area simply by dragging the object type and dropping it onto 
the canvas or by double-clicking the component.

Standalone Text and Graphic Components

Two component types are intended for data with standalone text or graphics:

 • Text Area

 • Graphic

The Widgets tool uses the Graphic component to support the addition of standalone images. Each 
time a graphic component is added to a widget, it is added in numerical order as a Layer on the 
canvas.

Data Feed Components

Cisco StadiumVision Director Release 3.1 introduces two new component types to support generic data 
sources and feeds, whose content is either image-based or text-based.

P2S (PicToScreen)

The PicToScreen component supports only image data fields from the data source, and can display up to 
5 images from a data feed. The images appear in a fixed overlapping cascade that rotates through the 
available images from the feed (Figure 1). 

Note The cascading layout of the images cannot be changed. However, you can alter the position and 
orientation of the top graphic within the Widgets tool.
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Figure 1 Example of PicToScreen Widget Display of 5 Maximum Images

Default Images and Display Behavior

Cisco StadiumVision Director has default images that are used as placeholders for any images that 
cannot be found or when the number of images received does not equal the number defined in the 
“Images to Display” property of the PicToScreen component (up to 5).

If Cisco StadiumVision Director must insert default images when enough images are not received from 
the data feed, then only the good images from the data feed are rotated through the cascading 
presentation. The default images will remain at the back of the stack in the presentation. 

The default image is called DefaultImg.jpg and is found in the content library. You can change the 
default image by uploading your own image into the content library and change the “ContentName” 
property in the P2S component.

Image Orientation

You can change the position and rotation of the top graphic in the PicToScreen component. However, 
you cannot control the position or rotation of individual images within the stack.

T2S (TextToScreen)

The TextToScreen component can support any number of messages from the data feed. 

Figure 3 shows an example of a fixed background graphic component, with a TextToScreen component 
overlay in Figure 3.

Figure 2 Example of TextToScreen Widget Background Graphic
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Figure 3 Example of TextToScreen Widget Display

Layers
Similar to standard graphics editing applications, each time a Text Area or Graphic component is added 
to a widget, it is labeled in numerical order (by type) as a Layer on the canvas. Unless reordered, the first 
component added is at the bottom of the components added to the canvas, and the last component added 
is the topmost layer. In the user interface, the Layers box also lists the layers in stacking order with the 
topmost layer at the top of the list. In general, a background image should be at the bottom of the list.

You can reorder the layers by dragging and dropping them into a different order in the Layers box of the 
Widget tool.

The first graphic component added to the widget is identified as “graphic 1,” and the first text area is 
labeled “text area 1.” Components are numbered sequentially as they are added. Therefore, if you delete 
a component, that component number is not replaced. 

Tip You can rename a component by double-clicking it.

Properties and Effects
The Properties panel allows you to set the characteristics of a component including explicitly setting its 
size, location, and rotation on the canvas. 

Depending on the component type, some additional Properties and Effects are available:

 • Standalone Text Area Component Properties and Effects, page 53

 • Standalone Graphic Component Properties, page 54

 • PicToScreen Component Properties and Effects, page 55

 • TextToScreen Component Properties and Effects, page 56

Standalone Text Area Component Properties and Effects

In addition to setting the size, location, and rotation on the canvas for Text Area components, you also 
can specify the character string for the component, and select a font size and color. 

Table 1 describes the property options and Table 2 describes the effects that can be applied to standalone 
Text Area components.

Tip Remember that the Widgets tool displays a white background for ease of use, but if you are not 
using any background images, a black font will not be visible on the TV screen because the TV 
background is actually black.
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Standalone Graphic Component Properties

In addition to setting the size, location, and rotation on the canvas for Graphic components, you can 
import an image and also specify that it retain the dimensions of the original image.

Table 1 describes the property options that can be applied to standalone Graphic components. No effects 
are supported for Graphic components.

Table 1 Text Area Component Properties 

Property Name Description Values

x Number of pixels that defines the starting position of 
the component horizontally.

Range is 0–1920.

y Number of pixels that defines the starting position of 
the component vertically.

Range is 0–1080.

width Number of pixels that defines the horizontal width of 
the component.

Range is 0–1920.

height Number of pixels that defines the vertical height of the 
component.

Range is 0–1080.

rotation Number of degrees to rotate the component box. Range is 0–360. Default is 0.

Text Character string to display within the text area 
component.

Note The Text property does not support line wrap, 
so the length of the string that can be 
supported is the canvas width.

Default is “TextAreaN,” 
where N is a number in 
sequential order of the 
number of Text area 
components added to the 
canvas. 

Font Size Size of the Arial font for the Text property. Default is 36. Maximum is 
128.

Color Color for the Text property. Default is black.

Table 2 Graphic Component Properties 

Property or Effect Name Description Values

x Number of pixels that defines the starting position of 
the component horizontally.

Range is 0–1920.

y Number of pixels that defines the starting position of 
the component vertically.

Range is 0–1080.

width Number of pixels that defines the horizontal width of 
the component.

Range is 0–1920.

height Number of pixels that defines the vertical height of the 
component.

Range is 0–1080.

rotation Number of degrees to rotate the component box. Range is 0–360. 
Default is 0.
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PicToScreen Component Properties and Effects

Table 3 describes the property options and Table 4 describes the effects that can be applied to 
PicToScreen components.

Content Name Filename of the image to be displayed in the 
component. 

Note The image must be uploaded to the Content 
Management System (CMS) from the Control 
Panel > Content > Import area of Cisco 
StadiumVision Director to be made available 
to the widget.

Unspecified. 
Default images 
from the system 
are used.

Use image original size When selected, changes the image size in the 
component to the size stored in the CMS.

Note If you select this option and then unselect it, 
the image does not revert to the settings in the 
widget.

Default is 
disabled.

Table 2 Graphic Component Properties (continued)

Property or Effect Name Description Values

Table 3 PicToScreen Component Properties 

Property or Effect Name Description Values

x Number of pixels that defines the starting position of 
the component horizontally.

Range is 0–1920.

y Number of pixels that defines the starting position of 
the component vertically.

Range is 0–1080.

width Number of pixels that defines the horizontal width of 
the component.

Range is 0–1920.

height Number of pixels that defines the vertical height of the 
component.

Range is 0–1080.

rotation Number of degrees to rotate the component box. Range is 0–360. 
Default is 0.

Images to Display Maximum number of images to display from the data 
feed.

Tip The value of the Images to Display property 
should match the value of the “Number of 
messages keep” data option for an Atom or 
RSS feed data source.

Range is 2–5. 
Default is 5.

Use default image if no 
image present.

When enabled, replaces any missing images that 
might occur from the data feed (up to the maximum 
number for display) with a default image.

Default is 
enabled.
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TextToScreen Component Properties and Effects

Table 5 describes the property options and Table 7 describes the effects that can be applied to 
TextToScreen components.

Content Name Filename of an image to be used as the default when 
default images are enabled for the component.

Unspecified. 
Default images 
from the system 
are used.

Image Duration Length of time (in seconds) to display the current set 
of images.

Range is 5 to 25. 
Default is 5.

Table 4 PicToScreen Component Effects

Property or Effect Name Description Values

Image Duration Length of time (in seconds) to display the current set 
of images.

Range is 5 to 25. 
Default is 5.

Table 3 PicToScreen Component Properties (continued)

Property or Effect Name Description Values

Table 5 TextToScreen Component Properties 

Property or Effect Name Description Values

x Number of pixels that defines the starting position of 
the component horizontally.

Range is 0–1920.

y Number of pixels that defines the starting position of 
the component vertically.

Range is 0–1080.

width Number of pixels that defines the horizontal width of 
the component.

Range is 0–1920.

height Number of pixels that defines the vertical height of the 
component.

Range is 0–1080.

rotation Specifies the orientation of the component. Horizontal or 
vertical. Default 
is horizontal.

Font Size Size of the Arial font for the text that appears in the 
component.

Default is 36. 
Maximum is 128.

Font Color 1 Sets a font color for the first text data field in a feed, 
and alternates with Font Color 2. If there is only one 
message, then only Font Color 1 is used.

Default is black.

Font Color 2 Sets a font color for the second text data field in a feed 
and alternates with Font Color 1.

Default is black.
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Data Binding and Preview
After you have mapped the output fields for an external data source, you can bind that data to a 
component in a widget and see a preview of that live content feed.

Note Live data is polled for preview every 15 seconds in the Widgets tool. There can be a slight delay before 
you see an update of the content within a component. This polling interval is for preview only and is not 
the same polling interval used in the data source configuration.

Only certain data fields are supported for the PicToScreen and TextToScreen components. For more 
information, see the “Restrictions for Using the Widgets Tool” section on page 50.

User Interface Characteristics
Figure 4 shows the areas of the user interface for a new widget.

Figure 4 New Widget Interface

The Widgets tool interface supports some of the following functions and characteristics:

 • Multi-selection of components using standard Control key sequences to move components as a 
group.

 • Showing or hiding the bounding box of a component.

 • “Zoom-to-fit” function by double-clicking the zoom knob.

 • Change the widget dimensions by double-clicking the widget size in the upper right of the screen.

Table 6 TextToScreen Component Effects

Effect Name Description Values

Fade Gradually shows the text data field in the component. —

Message display 
duration (Seconds)

Length of time (in seconds) that the text from the data 
feed is displayed. 

Range is 5–25. 
Default is 5.
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How to Design the Layout of External Content for Display
This section includes the following tasks:

 • Accessing the Widgets Tool, page 58

 • Creating New Widgets, page 58

 • Working with Images, page 60

 • Adding Text Areas, page 62

 • Showing the Component Bounding Box, page 63

 • Resizing and Rotating Components, page 64

 • Binding External Data to a Widget, page 65

 • Modifying Existing Widgets, page 66

Accessing the Widgets Tool

To access the Widgets tool, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the main menu, click Control Panel > Widgets.

A dialog box opens for you to select an existing widget or create a new one (Figure 5).

Figure 5 Dialog Box to Open Existing or Create New Widgets

Creating New Widgets
You can create a new widget when you first access the Widgets tool, or you can create a new widget from 
within the tool.
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To create a new widget from within the tool, complete the following steps:

Step 1 From the menu bar in the Widgets tool, click File > New.

The Create New dialog box is displayed (Figure 6).

Figure 6 Create New Dialog Box

Step 2 In the Name box, type a name for your new widget.

Step 3 Do one of the following to specify the size of the widget:

 • Click Pre-Set size and click the drop-down list to select a predefined dimension (WxH) for the 
canvas in pixels.

 • Click Custom Size and specify a number (in pixels) for the width and height dimensions of the 
canvas.

Step 4 Click Create.

The tool displays a white box of the size that you created, with the dimensions that you specified 
displayed in the upper right corner (Figure 7). 

Note The background canvas of the widget is actually transparent, but it is not shown with the 
graphics-standard checkerboard pattern to ease visibility of the components.

Figure 7 New Widget Screen
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Step 5 Click File > Save.

Changes to the widget are saved.

Working with Images
This section includes the following topics:

 • Adding Standalone Images, page 60

 • Resizing and Rotating Images, page 61

Adding Standalone Images

Images can be added as a background to your layout in the Widgets tool, and they also can be bound to 
a data field using the External Content configuration, such as to add a team logo to a score field that will 
appear in the widget. 

To support the addition of a graphic bound to a particular external source data field, see the “Modifying 
the Output Format of a Statistic” section on page 43.

The Widgets tool uses the Graphic component to support the addition of images as a background or in 
other places on your canvas. 

Prerequisite

Before you can add an image to a widget, you must import the image file into Cisco StadiumVision 
Director by going to Control Panel > Content > Import to select and open a file. In the Import Content 
dialog box, specify any options and click Upload.

Procedure

To add an image to a widget, complete the following steps:

Step 1 Open or create the widget where you want to add an image.

Step 2 In the Components box, select the Graphic component and drag and drop it onto your widget canvas 
(Figure 8).
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Figure 8 Drag and Drop Graphic Component on Widget Canvas

Tip Double-click a component to automatically add it to the canvas.

Step 3 To add an image, be sure that the graphic component where you want to add the image is selected, and 
click Change.

Step 4 In the Select Image dialog box, highlight the image that you want to add and click Select.

The image is added and scaled to the size of your graphic component box (Figure 9).

Figure 9 Image Added to Graphic Component

Step 5 Click File > Save.

Changes to the widget are saved.

Resizing and Rotating Images

Images will automatically scale to the size of the graphic component box in the widget. 

Tip To find the size of your image file, use the List view for your images in Control Panel > Content. Select 
your image and look at the size in the Dimension field in the “Other content metadata” box.

You can scale the graphic to its original size after you add it, or if you modify the image size in the 
widget, you can revert back to its original size using the “Use original image size” option, which is 
recommended.
61
Cisco StadiumVision Director External Content Integration Guide

 



 

Designing the Layout of External Content Using the Widgets Tool
How to Design the Layout of External Content for Display
Figure 10 shows the options available on the Properties panel for a graphic component and displays the 
different bounding box handles that can be used to modify the size of a component box.

Figure 10 Graphic Component Properties Panel and Bounding Box Handles

You can modify the size and position of an image in the following ways:

 • Explicitly setting values on the Properties panel.

 • Selecting the bounding box and using the handles to modify it.

 • With the graphic component selected, select the “Use original image size” checkbox to revert the 
image to its original size when imported.

For more information, see the “Resizing and Rotating Components” section on page 64.

Adding Text Areas
A text area component is added to a widget in the same way as a graphic component, but with some 
different properties. A text area supports a character string, and font size and color selection.

Currently the only available font is Arial.

To add a text area to a widget, complete the following steps:

Step 1 Open or create the widget where you want to add the text area.

Step 2 In the Components box, select the Text Area component and drag and drop it onto your widget canvas.

Step 3 In the Properties panel, type the character string for the box, and select the font size and color.

Figure 11 shows the options available on the Properties panel for a sample text area component.
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Figure 11 Text Area Component Properties

Step 4 Resize or position the text area as needed. For more details, see the “Resizing and Rotating Components” 
section on page 64.

Step 5 Click File > Save.

Changes to the widget are saved.

Showing the Component Bounding Box
When you add a component onto the canvas, a temporary bounding box appears while the component is 
selected. If you move away from that component into another area of the canvas, you will not be able to 
see the boundaries of the component box.

Figure 12 shows an example of a text area and graphic component displaying the default setting without 
a visible boundary when the component is unselected. Notice that while the graphic component is 
selected the temporary bounding box is displayed in Figure 12, but when unselected it appears to 
disappear from the canvas (Figure 13).

Figure 12 Default Setting Without Bounding Box and Selected Component
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Figure 13 Default Setting Without Bounding Box or Selected Components

To display a boundary around all components in the widget, complete the following steps:

Step 1 From the menu bar, go to View.

Step 2 Click Show bounding box. 

A checkmark appears beside the option when the bounding box is enabled for display, and all 
components will display a boundary around them. 

Figure 14 shows an example of a text area and graphic component after the Show bounding box option 
is enabled.

Figure 14 Show Bounding Box Option Enabled

Step 3 Click File > Save.

Changes to the widget are saved.

Resizing and Rotating Components
You can resize and rotate both Text Area and Graphic components in the following ways:

 • Change the component location:

 – Select the component and manually drag it to the location that you want on the canvas.

 – Specify the x/y horizontal and vertical values directly in the Properties panel. 
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 • Change the component size:

 – Select and drag a handle on the component’s bounding box to enlarge or reduce the component 
size. If using a handle on a side of the box, only that dimension is changed. If using a corner 
handle, both dimensions of the box are changed.

 – Shift+Click on a corner handle to resize the box proportionally.

 – Specify the width and height values directly in the Properties panel.

 • Change the component angle:

 – Select the rotation handle and drag the box up or down to rotate it.

 – Shift+Click on the rotation handle and drag the box up or down to change the angle in 45 degree 
increments. 

 – Specify the rotation value in degrees directly in the Properties panel.

Figure 15 identifies the bounding box handles that you can use to resize and rotate components.

Figure 15 Bounding Box Handles

Binding External Data to a Widget
The widget supports the binding of external data to a text area component so that you can display 
dynamic output fields, such as game periods, scores, and so on from an external source.

Note If you add a text string to the component, it will be replaced by the real-time data from the output field 
that you specified in the Data Binding panel. 

Prerequisite

Before you can bind external data to a widget, you must have configured your external data source and 
mapped the output fields by going to Control Panel > Setup > External Content. For more information, 
see the “Configuring External Content Integration in Cisco StadiumVision Director”.
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Procedure

To bind external data to a widget, complete the following steps:

Step 1 Open or create the widget where you want to add the text area.

Step 2 In the Components box, select the Text Area component and drag and drop it onto your widget canvas.

Step 3 In the Properties panel, select the font size and color. Optionally, specify a character string if you want 
to temporarily see some content in the component while the widget is open. 

The font size and color will be applied to the bound data.

Step 4 In the Data Binding panel, double-click in the first cell under the Data Source heading and open the 
drop-down list (Figure 16).

Figure 16 Accessing the Data Source List

Step 5 Click the drop-down list and select the data source from which you want to bind data. Use the scroll bar 
to reveal all data sources as necessary (Figure 17).

Figure 17 Selecting the Data Source

Step 6 Double-click inside the cell for the data field and select the drop-down list to select the data output field 
that you want to display in the text area component (Figure 18).

Figure 18 Selecting the Data Field

Step 7 Click File > Save.

Changes to the widget are saved.

Modifying Existing Widgets
This section includes the following tasks:

 • Changing the Size of a Widget, page 67

 • Deleting Widgets, page 67

 • Renaming Widgets, page 67
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Changing the Size of a Widget

To change the size of a widget, complete the following steps:

Step 1 Open the widget whose size you want to change.

Step 2 From the Edit menu, select Widget Dimension.

Timesaver You can also double-click the widget size in the upper right corner of the screen to open the Change 
Widget Dimension dialog box. See the “User Interface Characteristics” section on page 57.

Step 3 In the Change Widget Dimension dialog box, specify the new width and height values.

Step 4 Click Change.

Deleting Widgets

To delete a widget, complete the following steps:

Step 1 From the File menu, select Manage Widgets.

Step 2 In the Manage Widget dialog box, select the widget that you want to remove.

Step 3 Click Delete.

Renaming Widgets

To rename a widget, complete the following steps:

Step 1 From the File menu, select Manage Widgets.

Step 2 In the Manage Widget dialog box, select the widget that you want to rename.

Step 3 Click Rename.

The widget name is changed to an editable box.

Step 4 Type a new name for the widget.

Step 5 Click Close.

Configuration Examples
This section includes the following topics:

 • Basic Widget Configuration Example, page 68

 • TextToScreen Widget with Merged Generic Data Sources, page 70
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Basic Widget Configuration Example

Note This example demonstrates use of the Text Area and Graphic components with data binding. The figures 
are based on the original interface for the External Content Integration feature; Therefore, some of the 
figures do not reflect all of the latest available components in the interface.

This section shows a basic widget configuration example to bind external data for an OES Ice Hockey 
Scoreboard data source. The example uses an image background (Figure 19) that creates static headings 
for Period, Time Outs, and Score, with companion text area components that will be created as layers on 
top of the background. 

These text areas will be positioned beneath the background image headings and will have real-time data 
bound to them to appear in the widget.

Figure 19 Image Background for Scoreboard Widget 

To create a widget and bind data to it, complete the following steps:

Step 1 Create a new widget with size 1920x1080.

Step 2 In the Components box, select the Graphic component and drag and drop it onto your widget canvas.

Step 3 With the graphic component selected, go to the Properties panel and click Change.

Step 4 In the Select Image dialog box, click on the background image that you want to add and click Select.

The image is added and scaled to the size of your graphic component box.

Step 5 In the Properties tab, specify the following values (Figure 20):

a. x and y—0

b. width —1920

c. height—1080

d. rotation—0
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Figure 20 Background Image Added to Graphic Component

Step 6 Create two new text area components to add “HOME” and “GUEST” as the specified text string 
positioned as layers on top of the background graphic component (Figure 21).

Figure 21 Addition of Home and Guest Text Areas

a. Drag and drop the Text Area component onto the background graphic.

b. In the Properties panel, specify the following values:

 – Text box—Type “HOME”

 – Font size—128

 – Font color—Choose yellow

c. Select the handles on the text area box and expand its boundaries enough to reveal the text.

d. Select the text area component and drag it to the left side of the background graphic over the Time 
Outs Left and Score fields.

e. Repeat steps a–d using “GUEST” text and drag the component to the right side of the background 
graphic.

Step 7 Add Text Area components to bind data for Period, Time Outs, and Score areas for both teams:

a. Drag and drop the Text Area component onto the background graphic.

b. (Optional) Zoom in as needed to see the component better.
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c. Position and resize the component beneath the heading for which you are going to bind 
corresponding data (Figure 22).

d. (Optional) Add text to temporarily identify what data will be in the box, such as “period_data.”

Figure 22 Text Area Component to Bind Period Data

e. In the Data Binding panel, select the OES: Ice Hockey, Scoreboard data source and the period data 
field (Figure 23).

Figure 23 Period Data Field Binding for OES Ice Hockey Scoreboard Source

f. Repeat steps a–e for all other data fields that you need to bind.

Step 8 Click File > Save.

Changes to the widget are saved.

TextToScreen Widget with Merged Generic Data Sources
This advanced example shows how to create generic data sources from RSS feeds, filter the data, and 
combine the feeds into a new data source for layout in the Widgets tool. The example highlights the 
following functionality in the External Content Integration feature:

 • Generic data source configuration of an RSS data feed.

 • Provision of XML sample data.

 • Selection of specific item ranges in a data feed using the XPath expression editor.
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 • Merging of data sources into a data view.

 • Data view configuration as a data source.

 • Preview of received data in the data source.

 • Use of a background graphic in the layout.

 • Overlay of a TextToScreen component with data bound from merged data sources (a data view).

 • Use of color properties in the TextToScreen component.

To create a TextToScreen widget with merged data sources, complete the following steps:

Step 1 From the Control Panel, click Data Integration.

For more information, see the “Accessing the External Content Integration Interface” section on page 17.

Step 2 Add a new Generic Data Source with the HTTP message type.

For more information, see the “Adding a New Data Source” section on page 17.

Step 3 In the Configuration panel for the new Generic Data Source, type the URL to your RSS feed.

Figure 24 creates a new Generic Data Source named “Twins_businessnews” with the following HTTP 
URL “http://feeds.reuters.com/reuters/businessNews”. The rest of the configuration uses the default 
values.

Figure 24 HTTP Configuration for First Generic Data Source 

Step 4 Click Field Mapping.

Step 5 Click the pencil icon to open the Sample data box, paste the sample XML data from the feed, and save it.

For more information, see the “Providing Sample XML Data for Generic Data Sources” section on 
page 28.
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Figure 25 shows a portion of the XML data pasted into the Sample data box.

Figure 25 Sample Data for First Generic Data Source

Step 6 Expand the RSS input fields made available from the sample data and select a text-based input field to 
be used in the output display. 

For more information, see the “Selecting Input Statistics and Mapping to Output Fields for Display” 
section on page 30.

Step 7 Select the Expression mapping option and click Ok.

The default XPath expression for the data field is added to the Mapping expression field. For an RSS 
title element, the default expression is “/rss/channel/title/text().”

Step 8 Click the pencil icon in the Output field icon bar to modify the XPath expression to filter the data 
provided by the feed.

Fore more information, see the “Modifying the Default XPath Expression” section on page 45.

Figure 26 shows a modification to the title data field to add the “item[position()>=2andposition()<5]” 
predicate to the default /rss/channel/title/text() expression:

/rss/channel/item[position()>=2andposition()<5]/title/text

In this example, the data will be filtered to pull the 2nd, 3rd, and 4th items in the title element of the feed.

Figure 26 Output Data Filter Using XPath Expression for First Generic Data Source
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Figure 27 shows selection of the “title” field for output display with the modified mapping expression 
and the 3 items available for data preview from the RSS feed.

Figure 27 Field Mapping for First Generic Data Source

Step 9 Click the link under Data preview to open the “Preview for” window, and verify the data from the RSS 
feed.

Based on the filter used in our example to pull 3 items from the title element, a link named “3 items” 
appears under Data preview. Figure 28 shows the preview of the three title items from the first generic 
data source RSS feed.

Figure 28 Data Preview for First Generic Data Source with Business Data

Step 10 Repeat Step 2–9 for the second generic data source whose RSS feed content you want to combine with 
the first generic data source.
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Figure 29 creates a second Generic Data Source named “Twins_sportsnews” with the following HTTP 
URL “http://feeds.reuters.com/reuters/sportsNews”. The rest of the configuration uses the default 
values.

Figure 29 HTTP Configuration for Second Generic Data Source

Figure 30 shows the corresponding XPath expression to filter the data to pull the 4th, 5th, and 6th items 
from the title element for the second generic data source.

Figure 30 Output Data Filter Using XPath Expression for Second Generic Data Source
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Figure 31 shows the preview of the 3 sports titles filtered from the second generic data source.

Figure 31 Data Preview for Second Generic Data Source with Sports Data

Step 11 To combine content from multiple data sources, click Advanced to create a data view and add the data 
sources that you created.

For more information, see the “Working with Data Views” section on page 37.

Figure 32 shows creation of a data view named “Twins_BusinessandSportsnews” with the 
“Twins_businessnews” and “Twins_sportsnews” data sources included.

Figure 32 Data View Creation with Two Generic Data Sources Added

Step 12 Configure a third generic data source that connects internally to the created data view.

For more information, see the “Configuring the Data View as a New Data Source” section on page 42.
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Figure 33 shows configuration of the internal HTTP URL using the Cisco StadiumVision Director server 
IP address and the name of the “Twins_BusinessandSportsnews” data view.

Figure 33 Data View HTTP Configuration

Step 13 Go to Field Mapping and provide the sample XML data for the combined data sources.

The following is an example of the sample XML used:

Note The “entry” node is required in the sample data.

<command>
  <type>xmlDataFeed</type>
  <version>1</version>
  <channel>com.cisco.sv.databind</channel>
  <xmlDataFeed>
    <hashcode>45adde4260b54cb41765345a21efd3dc</hashcode>
    <xmlDataFeedEntry>
      <name>.Twins_businessnews.title</name>
      <value>
        <entry index="0">Exclusive:Thermo Fisher weighs Life Tech takeover - 
sources</entry>
        <entry index="1">Chesapeake CEO McClendon steps down after year of tumult</entry>
      </value>
    </xmlDataFeedEntry>
    <xmlDataFeedEntry>
      <name>.Twins_sportsnews.title</name>
      <value>
        <entry index="0">Never-say-die Kings rally to haunt Canucks again</entry>
        <entry index="1">49ers' Moss: "I'm the greatest receiver ever"</entry>
        <entry index="2">MLB investigating doping report involving top players</entry>
      </value>
    </xmlDataFeedEntry>
  </xmlDataFeed>
</command>

After the XML sample data is saved, the data sources are combined. 
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Figure 34 highlights the new link to 6 items available for preview, which includes the 3 items from the 
business data source and 3 items from the sports data source.

Figure 34 Data View Field Mapping

Step 14 Click the link in the Data preview column to verify the content for display.

Figure 35 shows the combined title items from both the business and sports feeds.

Figure 35 Data View Field Mapping

Step 15 Go to the Widgets tool.

For more information, see the “Accessing the Widgets Tool” section on page 58.

Step 16 Create a new widget.

For more information, see the “Creating New Widgets” section on page 58.

Step 17 Add a Graphic component to the canvas and adjust the size to accommodate the title fields from the RSS 
feeds.

For more information, see the “Working with Images” section on page 60.

Step 18 Add a TextToScreen component to the canvas to overlay the Graphic component.
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Step 19 Bind the data view data source to the TextToScreen component.

Figure 36 shows binding of the “Twinsbusinessandsports” data source.

Figure 36 Data Binding of the Data Source Created From the Data View

Step 20 In the Properties panel, set the options and choose the font colors.

Figure 37 shows the properties used with black set for the first color, and red set for the second color. 
The bound data automatically appears in the widget. Since two different colors were set in the 
component properties, the colors will alternate for each message.

Notice that the first message of the combined data that was displayed in the Data Integration preview in 
Figure 35 appears in the Widget in black font, followed by the second message in red.

Figure 37 TextToScreen Data Preview of First Message Color
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What to Do Next
After you have completed creating a widget, complete the following steps to publish it for display:

1. Create a playlist from the Control Panel for the widget that you created. Widgets are categorized in 
the “By Type” folder under the “widget” type.

2. Create an event script to run the playlist.

3. Schedule the script to display the content on a TV.
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Troubleshooting External Content Integration in 
Cisco StadiumVision Director

First Published: August 2, 2012
Revised: March 27, 2013

This module describes how to monitor and troubleshoot problems with External Content Integration in 
Cisco StadiumVision Director.

This module includes the following topics:

 • Monitoring the External Content Integration Log, page 81

 • Troubleshooting NFL GSIS Statistics Problems, page 83

 • Troubleshooting Missing Data Feed Content, page 83

Monitoring the External Content Integration Log
All logging messages for External Content Integration are written to the following log file and location:

/opt/sv/servers/mule/mule.log

While logging can always be seen directly from the Unix console, you can also view messages using the 
log viewer in the Management Dashboard. When you start the log viewer, informational messages are 
displayed as the default severity level.

The log file is compressed once a day at 24:00.

Starting and Stopping the Log Viewer
If logs are turned on, they increase in size over time, which can lead to disk space issues. Therefore, it 
is recommended that you use the log functionality only during troubleshooting.

To start and stop the log viewer, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3 Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.
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Step 4 Do the following:

 • To start logging, select Start Log Viewer.

 • To stop logging, select Stop Log Viewer.

Step 5 Click the Play button to run the command.

Modifying the Severity Level of Messages Displayed in the Log Viewer

Caution The logging service for External Content Ingestion can produce a very large number of messages when 
you specify the debug severity level, many of which can be seen only from the Unix console. Be sure to 
stop the log viewer or change the severity level of messages being logged, and do not allow the log to 
run continuously in debug mode to avoid potential problems with system performance or an unusually 
large log file. This can also use a lot of disk space on the hard drive.

The External Content Integration log supports 4 severity levels for messages, and each increasing 
severity level is cumulative and includes the logging of all message severity levels below it:

 • Debug

 • Info—This is the default.

 • Warn

 • Error

To modify the severity level of messages displayed in the log viewer, complete the following steps:

Step 1 Log into Cisco StadiumVision Director as an administrator.

Step 2 From the Cisco StadiumVision Director main menu, click Management Dashboard.

Step 3 Using the Management Dashboard drawers, go to Tools > Settings > External Content Integration.

Step 4 In the System panel, click the arrow in the Log Level drop-down list box:

a

Step 5 Select the severity level of the message that you want to view in the log.
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Troubleshooting NFL GSIS Statistics Problems
To troubleshoot any problems with obtaining the NFL GSIS statistics, look at the following areas:

 • Verify that the GSISGameStats.xml file resides on the SIAB server in the root directory.

Note There are five other GSIS files in this directory, but only the GSISGameStats.xml file is used by 
Cisco StadiumVision Director.

 • Verify connectivity to the SIAB server and access to the XML file using the following command 
from a Unix console on Cisco StadiumVision Director:

curl -u ‘user:pswd’ ftp://ip-address/GSISGameStats.xml

where user and pswd are replaced with your SIAB server username and password credentials from 
the NFL GSIS representative, and ip-address is replaced by the IP address of your SIAB server.

 • Check the External Content Integration logs in the Management Dashboard for FTP errors. For more 
information, see the “Monitoring the External Content Integration Log” section on page 81.

 • Restart the External Content Integration application from the Management Dashboard by navigating 
to Tools > Settings > External Content Integration > Restart Application.

Troubleshooting Missing Data Feed Content
It might take up to two times your polling interval for data to appear in your preview pane.

To troubleshoot any problems with data feed content not appearing in preview, look at the following 
areas:

 • Be sure that you have enabled the data source configuration (click Deploy in the Data Integration 
screen). You must deploy the feed to make the data available to the External Content Integration 
service. For more information see the “Enabling the Data Source Configuration” section on page 31.

 • Restart the External Content Application. The External Content Application must be restarted 
whenever you modify the configuration and save it, and after deployment. For more information, see 
the “Restarting the External Content Integration Application” section on page 33.
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